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Welcome to jPDFViewer v2022R1 – Java PDF 
Viewer

End User Guide for integrated PDF viewer in applications or 
websites.

This guide serves as a reference tool for end users using jPDFViewer deployed in a Java 
or a Java webstart application.

Note: Some features and functionality within this guide may not be available 
depending on what has been enabled/disabled in your distribution. Contact your 
application administrator for additional details.

jPDFViewer Features:

Open and display PDF files
Print PDF files
Fill interactive PDF forms (Acroforms, XFA forms)
View existing markup annotations on PDF documents
Validate and display digital signatures
Text search and selection
Advanced display tools: zoom, loupe, snapshot, pan and zoom
Easy navigation with different views: thumbnails, bookmarks, annotations, etc…
Full support for the following:

The latest PDF formats
All image types, including JBIG2 and JPEG 2000
All PDF font types (Types 0-3, OpenType, TrueType)
All PDF colors spaces including pattern and separation
File attachments

Available in English, French, German, Italian, Spanish
Works on Windows, Mac OS X, Linux and Unix (100% Java)

Downloadable User Guides

The following user print versions of the user guides are available for download.

Word

jPDFViewer User Guide (.docx)

PDF

jPDFViewer User Guide (.pdf)

https://www.qoppa.com/files/pdfviewer/userguide/jpdfviewer_userguide.docx
https://www.qoppa.com/files/pdfviewer/userguide/jpdfviewer_userguide.pdf
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Getting Started with jPDFViewer
To start using jPDF Viewer, simply launch and open a PDF document using the Open 

button  on the toolbar. Once a document is loaded, you can print or navigate 
through the document at any time using the toolbar.

The Toolbar

The Toolbar is located at the top of the jPDF Viewer window. The toolbar is where you 
will find all of the most commonly used functions in jPDF Viewer.

Panes

Panes are where you will find additional tools or information on the current document. 
These panes can be resized by clicking and dragging the edge of the pane. Pane can 
also be completed closed by either clicking the "x" on the top right of the pane, using 
the toggle buttons on the left of the jPDF Viewer window.

Details of each of the panels are listed below.

Left Pane

The left pane can show one of four different views. The views can be toggled by their 
respective buttons on the left side of the screen. The following views are available:

Pages Pane – view miniature versions of all the pages in the documents. Click a 
thumbnail to go to that page.  
Bookmarks Pane – view bookmarks or the document's table of contents, if present. 
Bookmarks allow navigation through bookmarked regions.
Destinations Pane - view PDF destinations
Attachments Pane - view files that have been attached to the PDF document, if any. 
Attached files can be viewed, saved, or deleted.
Layers Pane – view layers contained in the document, if any. You can toggle layers 
by checking them on or off.
Signatures Pane – view digital signatures that have been applied to the document.

Bottom Pane

The Comments view in the bottom pane shows any comments / annotations in the 
document. Navigate to a specific comment by selecting it in the list.
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jPDFViewer Toolbar
The toolbar is located at the top of the jPDF Viewer window. The toolbar is where you 
will find all of the most commonly used functions in jPDF Viewer.

The default toolbar is setup as displayed above but can vary depending on your 
application setup.

Toolbar Descriptions

File

 Open: Open a PDF document.

 Print: Print the current document.

Navigation

 First Page: Navigates to the first page of the document.

 Previous Page: Navigates to the previous page in the document.

 Page Number: Displays the current page being viewed and the total 
number of pages. Type a number into the field and press "Enter" to navigate directly 
to that page.

 Next Page: Navigates to the next page in the document.

 Last Page: Navigates to the Last page in the document.

 Previous View: Navigates to the last view within the document.

 Next View: Navigates to the next view within the document.

Page Fit

 Actual Size: Displays the document with a 1:1 ratio to match how the document 
would look if printed without any scaling.

 Fit to Width: Scales the view to fit the width of the document in the jPDF Viewer
frame.
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 Fit to Page: Scales the view to fit the entire  document within the jPDF Viewer
frame.

View Rotation

 Rotate View Clockwise: Rotates only the view within the document clockwise 
(Note: This rotation will NOT be saved when the document is saved then reopened).

 Rotate View Counter Clockwise: Rotates only the view within the document 
counter clockwise (Note: This rotation will NOT be saved when the document is 
saved then reopened).

Zoom

 Zoom Out: Zoom out to view the content smaller.

 Zoom To/Current Zoom: Displays the current zoom value. You can also 
select a preset zoom percentage or type in the field for a custom zoom value.

 Zoom In: Zoom in to view the content larger.

 Zoom Tool: Zooms to a selected area within a page. Click and drag to select the 
rectangle area you wish to zoom to.

 Loupe Tool: Displays a zoom window that zooms in on the PDF to show the 
smallest detail.

 Pan and Zoom:  A window showing the portion of the page currently on screen. 
Drag the red box to adjust the view of the document.

Standard

 Drag and Scroll Page: Click and drag to scroll or move the pages.

 Select Text: Click and drag to select text within the document.

 Take Snapshot: Used to save a portion of the screen as an image.

 Search Text: Used to search the text of a PDF document.

 Underline: Makes the selected annotation or text underlined

 Strikethrough: Marks the selected annotation or text with a strikethrough



Qoppa Software

Others

 Divider: separates each of the toolbar sections.
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Selecting Text

Click on the Select text icon  on the toolbar, then drag the mouse to select the 
desired objects. When right-clicking on the mouse (Mac: Ctrl + Click), a menu will 
appear giving you the choice to copy the text to the clipboard;

     Note : When copying text it will preserve Font, Color, Size, Bold & Italic properties 
of the selected text.

To exit the selection mode, simply click on the hand tool  or Esc on the keyboard.

 

Rectangular Text Selection

For rectangular text selection, hold down Ctrl (Command for OSX) while dragging the 

mouse.  The cursor will change to  to indicate that a different selection mode is 
active.

 

Text Selection Options

 Copy to Clipboard - copies the selected text to the OS clipboard

Paste - pastes the content currently stored in the OS clipboard into the document

Text: will be pasted as a Text Box Comment
Image: will be pasted as an image stamp
File Data: will be pasted as an attachment
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Markup Tools

 Highlight Text - highlights the selected text

 Underline Text - underlines the selected text

 Cross Out Text - adds cross out to selected text

 Replace Text - adds replace text markup to selected text

 Mark for Redaction - add redaction annotation to selected text
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Snapshot Tool
The snapshot tool can be used to save a portion of the screen as an image.

Select the snapshot tool icon  from the toolbar then drag the mouse over the page 
to select the snapshot area.

When the mouse button is released, an image will be created from the selected area. 
The image is copied to the system clipboard.
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Quick Search
With jPDFViewer v2022R1, you can quickly search for text within a PDF document. The 
quick search tool allows you to search for just the next occurrence of the text within 
the document. To find a list of all occurrences within the document use the Advanced 
Search instead.

How to use Quick Search

Open the document that you wish to search
Open the quick search popup by going to Edit > Search or using the shortcut key 
Ctrl + F (Command + F on Mac)
Enter the text you wish to search for and press the "Enter" key to find the next 
occurrence of the text within the document

Quick Search Options

 Previous Occurrence: Navigates to the previous occurrence of the word in the 
document

 Next Occurrence: Navigates to the next occurrence of the word in the document

Note: Pressing the "Enter" key will also continue to the next occurrence

 Search Options: Used to set the quick search options. Click on the arrow to select 
the options you wish to use

Advanced Search: This will open the Advanced Search and begin searching for 
the text currently in the search field.
Case-Sensitive: If checked, searching for the string "The" will not return the 
same results as searching for the string "the".
Whole words only: If checked, searching for "the" will not return occurrences of 
"they". But when this option is left unchecked, all occurrences of "they", and 
other words with the letters "the", will appear in the occurrence list.
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Include comments: If checked, the search will include text in annotation 
comments.
Include fields: If checked, the search will include text in form fields. (this is on 
by default)
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Text Search
The Advanced Text Search tool in jPDFViewer allows you to see a complete list of all the 
results. This tool allows you to see the results of the search in context with the text 
around the result to help locate the section of the document with the correct text.

How to use Advanced Search

Open the document that you wish to search

Click on the Text Search button  on the toolbar, press Ctrl + Shift + F (Cmd + Shift 
+ F on Mac)
Enter the text to search for in the text field, and press the Enter key or click on the 
Search button. All occurrences of the text in the document will appear in the 
occurrences list.

To navigate through the results:

Use the Up arrow key (previous) and Down arrow key (next).
Click on the Previous Occurrence or Next Occurrence buttons next to the New Search 
button.
Use the F3 (next) and Shift + F3 (previous) keys.
Click on the result with the mouse

Advanced Search Options

 Previous Occurrence: Navigates to the previous occurrence of the word in the 
document
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 Next Occurrence: Navigates to the next occurrence of the word in the document

Note: Pressing the "Enter" key will also continue to the next occurrence

Case-Sensitive: If checked, searching for the string "The" will not return the same 
results as searching for the string "the".

Whole words only: If checked, searching for "the" will not return occurrences of "they". 
But when this option is left unchecked, all occurrences of "they" will appear in the 
occurrence list.

Include comments: If checked, the search will include text in annotation comments.

Include fields: If checked, the search will include text in form fields. (this is on by 
default)
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Printing PDFs
PDF documents can be printed from within jPDF Viewer. To print a document just click 

on the Print  button on the toolbar.

Print Options

The below print options are available when using the jPDF Viewer Print dialog. Settings 
options will be enabled and disabled based on what the printer tells jPDF Viewer is 
available.

Note: There may be some cases where the printer may support an option that is 
listed as disabled because it was not reported as available to jPDFViewer.

Printer - The name of the printer you wish to print to
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Copies - The number of copies of the document to be printed

Collate:  Keeps pages in order when printing multiple copies. For example, if 
unchecked, two copies of a three-page document will print in this order: 1,1,2,2,3,3. If 
checked, the order will be 1,2,3,1,2,3. This option is not available when printing only 
one copy.

Print to File - Option to print to a .prn file instead of directly to the printer. This allows 
you to reprint the document without running or even having the original application 
that created the file. For example, if you need to send the document to a printing 
company that only prints on a specific printer.

General

Page Range

All Pages: all pages in the document

Current Page: the current page being displayed

Current View: prints the page exactly as it is displayed in the current PDF jPDFViewer
frame. Note: This option will be disabled if more than one page is currently being 
displayed.

Selected Pages: prints the pages currently selected in the thumbnails pane

Pages: set custom range of pages if needed using values separated by commas. For 
example, to print only pages 2 to 4 & 6 to 12 & 20 of a 30 page document enter “2-4, 
6-12, 20″.

Subset: Subset of the currently set page range to print. Choose from the below options

All pages in range: prints all the pages in the set range
Even pages only: prints only the even pages in the set range (i.e. 2, 4, 6, etc...)
Odd pages only: prints only the odd pages in the set range (i.e. 1, 3, 5, etc...)

Reverse Pages: reverse the order in which the pages will come out of the printer

Standard Printing

Sides - The options to print pages either one sided or on both sides of the paper

One-sided: prints only one page on the front of each sheet of paper
Two-Sided (short edge): prints two pages, one on front and one on back, per sheet of 
paper flipping the page on the short edge
Two-Sided (long edge): prints two pages, one on front and one on back, per sheet of 
paper flipping the page on the long edge

Print Options - Additional print options to size the content to the page.
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Center In Page: center the page in the paper. No effect if the pages in a document 
are larger than the paper they are being printed on.
Shrink To Margins: shrink pages so that they fit in the paper. No effect if the pages 
in a document are smaller than the paper they are being printed on.
Expand To Margins: expand pages to fill the paper they are being printed on. No 
effect if the pages in a document are larger than the paper they are being printed on.
Scale: Sets a custom scale to the document when printing. This option is only 
available when Shrink to Margins or Expand to Margins are not selected.

Multiple Pages per Sheet Printing

Pages per sheet: Number of pages from the document that should be printed per 
sheet. Pages will be added to the sheet using evenly spaced grids

Page order: Options to order the pages Horizontally from top to bottom or Vertically 
from left to right

Page margins: Adjusts the spacing between each of the page grids

Sides - The options to print pages either one sided or on both sides of the paper

One-sided: prints only one page on the front of each sheet of paper
Two-Sided (short edge): prints two pages, one on front and one on back, per sheet of 
paper flipping the page on the short edge
Two-Sided (long edge): prints two pages, one on front and one on back, per sheet of 
paper flipping the page on the long edge

Auto-rotate individual pages in sheet: Rotates each individual page so that the width 
and length best fit each of the individual grids on the sheet.

Print border: When checked adds a border around each of the pages on the sheet

Booklet Printing

Booklet subset: Subset of the currently set page range options. Choose from the below 
options

Both Sides (long edge): This will print all of the booklet pages on both sides of each 
sheet of paper so that when folded will create a booklet.
Front sides only: Will work just as it currently does only printing the front sides of 
the booklet so the user can flip the pages and print the back sides to manually 
duplex if needed.
Back sides only: Will work just as it currently does only printing the back sides of the 
booklet

Page margins: Adjusts the spacing between each of the page grids

Binding: Determines whether the binding (folded edge) of the booklet when folded 
should be on the left or the right
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Auto-rotate individual pages in sheet: Rotates each individual page so that the width 
and length best fit each of the individual grids on the sheet.

Print border: When checked adds a border around each of the pages on the sheet

Paper

Paper Size - The size of the paper to be printed on. This sizes in the list are determined 
by the printer that is selected

Paper Tray - The tray on the printer where the paper will be coming from

Orientation - The layout and direction of the content being placed on the page

Auto Rotate pages: rotate the printout to match the width and length with the paper. 
The portrait / landscape settings cannot be set by the user when this option is 
selected.
Portrait: print the page portrait
Landscape: print the page landscape
Reverse Landscape: print the page landscape but reversed

Advanced

Chromaticity - Sets the color of the document to be printed

Monochrome: will print in B&W or grayscale
Color: will print the document in color

Quality - Sets the quality of the pages to be printed

Draft: fast printing a low quality
Normal: normal print quality at standard speed. Best for most printing situations
High: high quality print for fine details. May take much longer to print

Performance - Sets additional advanced options to improve printing performance

Print as image - instead of sending drawing commands to the printer sends single 
image per page. Useful when running into performance issues on documents with 
very large amounts of drawing commands on the page
Scale image to output - tells the printer to rescale images to match output DPI, 
setting it to false sends the image in its original size and lets the printer resize it.

Comments & Forms

Print: Sets the printing options for documents with comments and forms

Document and Comments: prints the document with all comments
Document Only: prints the document without any comments. For a list of all 
comments that will be removed see Annotating and Commenting PDFs
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• Form Fields Only: prints only the form fields and no other content.

Note: Form fields are always printed with each of the above settings

Preview

The print preview panel displays  what the document will look like once printed based 
on the selected options, as well as contain navigation buttons allowing you to navigate 
the preview pages, and document properties showing selected paper and document 
sizes. Changing printing options will update the preview in real time.

Note: On Mac OS and Linux, some printers will always display "Color" even if the 
printer only prints in black & white.  

 First Page: Navigates to the first page of the preview document.

 Previous Page: Navigates to the previous page in the preview document.

 Page Number: Displays the current page being viewed and the total number 
of pages. Type a number into the field and press "Enter" to navigate directly to that 
page.

 Next Page: Navigates to the next page in the preview document.

 Last Page: Navigates to the Last page in the preview document.
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Touch Mode  

Touch mode can be enabled on your device by clicking on the Touch Mode icon   on 
the toolbar or going to View on the menu bar then selecting Touch Mode.

Features added specifically for Touch Mode.

Enlarged re-size handles on annotations and form fields for easier control
Enlarged fonts and rows in comments and thumbnail panes.
Mini toolbar during object selection for quick access to delete & show properties 
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Viewing and Comparing PDFs
jPDFViewer provides extensive functionality for viewing.

Viewing PDFs

Navigating: General navigation tips and tools

Zooming: Zooming in/out of the document

Setting Page Layout: Setting how the pages are displayed

Rotating Page View: Rotating the view of the page

Loupe Tool: Magnify a small region of the page

Pan and Zoom Tool: Display a window with the current location on the document

Invert Colors Mode: Invert colors when displaying PDFs for accessibility

PDF Layers: enable, disable, create, and edit layers.
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Comments Panel
The comments panel displays a list of all comments within the PDF document grouped 
by page. It provides an easy way to view and navigate comments within the document. 
The icon next to each comment will be displayed in the same color as the annotation 
displayed on the page.

Accessing the Comments Panel

View the comments panel by clicking the   comments button in the top right corner 
of PDF Studio. From this panel, you can view, search, and modify all the comments in 
the document.

The mouse is primarily used to navigate the comments panel. Clicking on any of the 
annotations listed will navigate the document to where the annotation is located on the 
page and select the current annotation. The following keyboard shortcuts can be used 
as well to navigate the comments panel.

Arrow Keys - Up and Down can be used to navigate up and down the annotation list
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Spacebar - Highlight an annotation and press space bar to toggle the check box.
Enter - Press Enter on a selected annotation to open the Note popup, then type the 
note you wish to add. Once complete press Esc to close the popup.

Comments Panel Toolbar

The following options are available at the top of the comments panel.

 Expand: Expands the comment tree to show all pages and review markups

 Collapse: Collapses the tree to only show the page folders

Status : Marks the selected annotation with a review status. See Setting Status or 
Check Marks

 Properties: Opens the properties for the selected annotation(s)

 Mark with Check Mark: Marks the selected annotation with a check mark. See 
Setting Status or Check Marks

 Delete: Deletes the selected comment

 Search: Enter text and press Enter to search for the text within the annotation 
comments

 Previous Search Result: Goes to the previous search result

Next Search Result: Goes to the next search result

 Filter: Allows you to filter out comments based on the following properties. Check 
the properties you wish to be shown and all annotations that do not have a property 
matching the selection will be hidden in the comments pane and on the page.

All: Select the "All" option to restore showing all the annotations. 
Author: list of authors found in the document
Type: list of annotation types found in the document
Marked: list of marked annotations in the document
Status: list of statuses found in the document
Color: list of annotation colors found in the document 

 Options: Contains additional comment panel options

Export: Export comments into a separate file.
FDF: File format created by Adobe that is supported by most PDF applications
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XFDF: Extended FDF file format created by Adobe that is supported by most 
PDF applications
Text: Simple text file (.txt) that will contain all of the annotation information
XML: File format that is similar to an Excel file that will contain all of the 
annotation information
CSV: Exports all comment data into the .csv format allowing you to view in any 
spreadsheet editor such as Microsoft Excel
highlighted Text: Creates a plain text file with all highlighted text separated 
by pages.

Print: Allows you to print the comments in the tree
Text: Prints just a simple text tree with all comments
Tree: Prints the entire tree exactly as it is displayed in the Comments Panel

Hide All Comments: When checked will hide all the comments from being displayed
View: turns on and off individual details displayed in the comments panel
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Navigating
jPDFViewer has a variety of methods that can be used to navigate PDF documents.

Using the Mouse

The primary method for navigating within PDF documents is with the mouse. jPDF 
Viewer is compatible with all standard mice and supports the following actions using 
the 2 buttons and scroll wheel typically found on the mouse.

Note: On Mac if using a mouse with a single button you can right click by holding 
Ctrl and clicking the mouse button

Left Mouse Button

Click to select items
Hold down to drag items

Scroll Wheel

Scroll the pages in the document

Right Mouse Button

Displays context menus with additional options

Panning/Moving Pages

With the hand tool  selected click and drag anywhere on the page to pan the 
document

Using the scroll wheel on the mouse you can move the document up and down

You can also use the vertical and horizontal scrollbars to pan the document by clicking 
and dragging on the scrollbar

Using the Keyboard

The keyboard can also be used in some cases to quickly navigate the document using 
shortcut keys. The following shortcuts can be used.

Action Windows/UNIX Mac
First Page Home Home
Last Page End End
Next Page PgDn or Space PgDn or Space
Previous Page PgUp or Shift + Space PgUp or Shift + Space
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Go to Page Ctrl + Shift + P ⌘ + Shift + P
Scroll Down Space or ↓ Space or ↓
Scroll Up  ↑  ↑
Next view Alt + → ⌘ + [
Previous view Alt + ← ⌘ + ]

Using the Navigation Tools

The navigation tools are located on the main toolbar and can be used to navigate the 
document.

 First Page: Navigates to the first page of the document.

 Previous Page: Navigates to the previous page in the document.

 Page Number: Displays the current page being viewed and the total 
number of pages. Type a number into the field and press "Enter" to navigate directly 
to that page.

 Next Page: Navigates to the next page in the document.

 Last Page: Navigates to the Last page in the document.

 Previous View: Navigates to the last view within the document.

 Next View: Navigates to the next view within the document.

Using Page Thumbnails

The page thumbnails can be found on the left side of the window. If not displayed the 

pane can be opened using the  Pages button on the left side of the screen

The page thumbnails show miniature versions of all the pages in the documents.

Click a thumbnail to go directly to that page.
use the Left ← and Right → arrow keys to navigate to the Previous and Next pages

Using Bookmarks

The bookmarks pane is located on the left of the window. If not displayed the pane can 

be opened using the  Bookmarks button on the left side of the screen.

Using bookmarks can be useful when navigating large PDFs that contain many pages. 
Often bookmarks are put in place to label chapters or sections within a document. Click 
on the bookmark to jump directly to that location in the document.
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Using Destinations

The Destination pane is located on the left of the PDF Studio window. If not displayed 

the pane can be opened using the  Destinations button on the left side of the 
screen.

Using destinations can be useful when navigating large PDFs that contain many pages. 
Destinations are additional navigation tools put in place to label specific locations or 
sections within a document. Click on the destination name to jump directly to that 
location in the document.
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Zooming
When viewing a document there are several ways to zoom in/out of the document.

Using the Mouse

To zoom in or out on the document using the mouse hold down Ctrl (Alt on Mac) and 
scroll the mouse wheel up to zoom in and down to zoom out.

Using the Keyboard

The keyboard can also be used in some cases to quickly zoom on the document using 
shortcut keys. The following shortcuts can be used.

Zoom to actual size Ctrl + 1 ⌘ + 1
Zoom to fit page Ctrl + 0 ⌘ + 0
Zoom to fit width Ctrl + 2 ⌘ + 2
Zoom in Ctrl + Plus Alt + Plus
Zoom out Ctrl + Minus Alt + Minus

Using the Zoom Tools

The zoom tools are located on the main toolbar and can be used to zoom on the 
document.

 Zoom Out: Zoom out to view the content smaller.

 Zoom To/Current Zoom: Displays the current zoom value. You can also 
select a preset zoom percentage or type in the field for a custom zoom value.

 Zoom In: Zoom in to view the content larger.

 Zoom Tool: Zooms to a selected area within a page. Click and drag to select the 
rectangle area you wish to zoom to.

Hold Ctrl key to zoom out while Zoom Tool is active. 

 Loupe Tool: Displays a zoom window that zooms in on the PDF to show the 
smallest detail.

 Pan and Zoom:  A window showing the portion of the page currently on screen. 
Drag the red box to adjust the view of the document.
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Setting Page Layout
When viewing a document there are several page layout options available to choose 
from.

Page Layouts

By default the page layout will be determined by the Initial View Settings in the 
document.  A different page layout can be selected when viewing the document.

Note: "To change these settings see the specific documentation of your application 
for detailed instructions"

Single: Displays only a single individual page at a time

Single Continuous: Displays all of the document's pages in a single column that can be 
continuously scrolled

Facing: Displays only two pages at a time side by side with odd pages on the left and 
even pages on the right

Facing Continuous: Displays all of the documents pages in two columns with odd 
pages on the left and even pages on the right

Cover: Displays the document just as when using Facing only the first page will be 
displayed alone

Cover Continuous: Displays the document just as when using Facing Continuous only 
the first page will be displayed alone

 

Page Views

By default the page view will be determined by the Initial View Settings in the 
document. A different page view can be selected when viewing the document by going 
to View > Zoom on the menu bar and selecting the view you wish to use or clicking on 
the button located on the toolbar.

 Actual Size: Displays the document with a 1:1 ratio to match how the document 
would look if printed without any scaling.

 Fit to Width: Scales the view to fit the width of the document in the jPDF Viewer
frame.
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 Fit to Page: Scales the view to fit the entire  document within the jPDF Viewer
frame.
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Rotating Page View
The pages of a document can be rotated temporarily, as if you were rotating a book or 
magazine in your hands. This can be accessed by clicking on the Rotate View  
icons on the toolbar.

Note: This rotation will NOT be saved when the document is saved then reopened.

 Rotate View Clockwise: Rotates only the view within the document clockwise

 Rotate View Counter Clockwise: Rotates only the view within the document 
counter clockwise



Qoppa Software

1.
2.

3.

4.

Loupe Tool
The loupe tool is a draggable rectangle that zooms in on the PDF to show the smallest 
detail. When active a second window will be displayed showing the current content that 
you are magnifying.

Instructions:

Click on the loupe tool  button on the toolbar
Click on the part of the page you would like to magnify. This will display the 
magnification window.
Use either the handles on the corners of the blue zoom area or the slider in the 
magnification window to change the level of magnification when using the tool
When finished to close the tool either click on the "x" on the magnification window 
or press Esc on the keyboard
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Pan and Zoom Tool
The Pan and Zoom tool is a second window will be displayed showing the portion of the 
page currently on screen. Drag the red box to adjust the view of the document.

Instructions:

Click on the pan and zoom tool  button on the toolbar. A second window will then 
be displayed showing a portion of the page currently on the screen.
To adjust the view of the document drag the red box or use the navigation and 
zoom tools in the pan and zoom window
When finished to close the tool either click on the "x" on the magnification window 
or press Esc on the keyboard
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Invert Colors
Inverting colors make things much easier to read on small screens, particularly when 
working in a dark room, on an airplane, or at night.

Note: "To change these settings see the specific documentation for your 
application for detailed instructions"

For typical documents, the display will change from "Black on White" to "White on 
Black".

Example Document with Invert Colors Enabled:
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1.
•

2.
3.

Show/Hide Layers
When viewing a document layers can be toggled on and off to create different views.

How to Show/Hide Layers in a PDF

Access the layers pane by clicking the Layers button on the left side of the screen.
Note: If the layers buttons is not displayed this means that the document does 
not contain any layers.

Show or hide layers by clicking the check box next to the layers name
Continue working on the document as you normally would

Note: Toggling the layers on and off does not modify the document and will not be 
saved.
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Opening Attached File
Files attached to PDFs can easily be opened. Depending on how the file is attached use 
one of the two methods below to open the file.

Note: jPDFViewer simply sends the file to your operating system for opening. If 
your operating system doesn't recognize the type of file or doesn't have the 
appropriate application to open the file, nothing will happen.

Embedded Files

If the file is attached as an embedded file, go to the attachments tab where the list 
of attached files is displayed, and double-click on the attached file. You can also 
right-click (Mac: Ctrl+Click) on the attached file and choose Open File.

Files Attached as Comment

If the file is attached as a comment, double-click on the file attachment comment on 
the page. You can also right-click (Mac: Ctrl+Click) on the file attachment comment 
and choose Open File.  You can also open the file from the attachments tab as you 
would embedded files.
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•
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Saving Attached File
Files attached to PDFs can easily be saved directly to your computer so that they no 
longer have to be accessed through the PDF. Depending on how the file is attached use 
one of the two methods below to save attached files.

Embedded Files

If the file is attached as an embedded file, go to the attachments tab where the list 
of attached files is displayed, right-click (Mac: Ctrl+Click) on the attached file and 
choose Save File.

Files Attached as Comment

If the file is attached as a comment, right-click (Mac: Ctrl+Click) on the file 
attachment comment on the page or in the attachments tab and choose Save File.
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PDF Forms
jPDFViewer supports standard form fields in PDF documents and allows you to fill out 
PDF forms in PDF documents.

Filling PDF Forms: Filling and completing existing PDF forms

Exporting PDF Form Data: Exporting form field data from PDFs

Importing PDF Form Data: Importing form field data into PDFs

Resetting Form Fields: Resetting existing PDF form fields to their default values

PDF Form JavaScript: Custom JavaScript actions that are supported in form fields
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Filling PDF Forms
jPDFViewer can be used to fill and complete existing interactive form fields within a 
PDF. Once complete the form can be printed just as any other PDF document.

How to fill PDF form Fields

To fill a PDF interactive form, simply open the document by clicking File -> Open and 
fill the forms using the instructions for each field type below. Use the Tab key to 
navigate to the next field and Shift + Tab to go to the previous field. To save all of the 
data entered into the PDF form, simply save the PDF document by going to File -> Save

or clicking on the save button .

Note: LiveCycle XFA forms – also called dynamic XFA forms – are not supported in 
jPDF Viewer.

The following form field types are supported in jPDF Viewer:
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Text Fields

Allows you to enter text into the field. In some cases there 
may be formatting rules in place that will only allow you to 
enter a specific type of information. For example: time or date 
fields.

Check Boxes
Can either be checked or unchecked. Multiple check boxes can 
be checked at once.

Radio Buttons
Similar to a check box except radio buttons belong to groups 
and so only one button in each group can be checked at a 
time

Combo Boxes
A drop down menu that displays a list of choices. Click on the 
down arrow to display the list of available options. In some 
cases this field will also allow custom text to be entered

List Box

Displays a list of multiple choice items in a box that can be 
selected. In some cases the field will also allow multiple items 
to be selected at once. To select more than one item at a time, 
hold down Ctrl or Shift and click on each of the options.

Buttons Performs an action when clicked

Signature 
Fields

A designated location to apply a Digital Signature to the 
document. Click on the field to place a signature
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Exporting Form Data
Form data can be exported from the current document into a file in FDF, XFDF, XDP, or 
XML formats. Form field data from all Form Field Types will be exported during this 
process.

Forms can be exported in the following formats

FDF: File format created by Adobe that is supported by most PDF applications

XFDF: Extended FDF file format created by Adobe that is supported by most PDF 
applications

XDP: An XML Data package created by Adobe that is supported by most PDF 
applications

XML: File format that is similar to an Excel file that will contain all of the 
annotation information

How to Export Form Data

Note: "To perform this function see the specific documentation for your application for 
detailed instructions"
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Importing Form Data
Form field data can be imported from either an FDF, XFDF, or XDP file into the current 
document. Any form data from any of the Form Field Types will be imported.

Note: Form data can only be imported into the exact same form as it was exported 
from meaning that both the field type and name have to be exactly the same in order 
for the data to be imported.

Comments can be imported using the following formats

FDF: File format created by Adobe that is supported by most PDF applications

XFDF: Extended FDF file format created by Adobe that is supported by most PDF 
applications

XDP: An XML Data package created by Adobe that is supported by most PDF 
applications

How to Export Annotations

Note: "To perform this function see the specific documentation for your application for 
detailed instructions"
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Resetting Form Fields
Reset Form Fields will reset the data in all fields in the form. When resetting a field, 
data will be set to the field's default value or to null if the field has no default value.

How to Reset Form Field Values

Note: "To perform this function see the specific documentation for your 
application for detailed instructions"
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PDF Form JavaScript
In jPDFViewer when creating custom functions/actions for specific items such as form 
fields or buttons you will need to use JavaScript for the commands. JavaScript can 
perform calculations, button actions (adding images, submitting forms, or populating 
other fields), validate field input, and set field formatting, among many other things.

Note: jPDFViewer only supports Acroform (non-LiveCycle) JavaScript in PDF forms.

You will need to have advance knowledge in programming JavaScript in order to create 
the actions for the buttons. For additional details on how to use these functions, take a 
look at the tutorials and lessons on this site http://www.w3schools.com/js/js_intro.asp

jPDFViewer supports the following JavaScript commands for each of the below items.

Supported JavaScript

Document

Methods:

addField
calculateNow
getAnnots3D
getField
getNthFieldName
getOCGs
resetForm

Properties:

calculate
numFields
numPages
URL

Fields

Methods:

buttonGetCaption
buttonImportIcon
buttonSetCaption
checkThisBox
clearItems
deleteItemAt
getArray

http://www.w3schools.com/js/js_intro.asp
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getItemAt
insertItemAt
isBoxChecked
setAction
setFocus
setItems

Properties:

borderColor
borderStyle
borderWidth
calcOrderIndex
charLimit
comb
commitOnSelChange
currentValueIndices
defaultValue
delay
display
doc
doNotScroll
doNotSpellCheck
editable
exportValues
fileSelect
fillColor
hidden
lineWidth
multiline
multipleSelection
name
numItems
page
password
readonly
required
strokeColor
style
submitName
textColor
type
userName
value
valueAsString
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Global

Methods:

setPersistent

OCG

Methods:

getIntent
setAction
setIntent

Properties:

initState
locked
name
state

Utilities

Methods:

printd
printf
printx



Qoppa Software

Digital Signatures
jPDFViewer. Digital Signatures are a way of authenticating the contents of a document. 
A document with a valid signature is guaranteed not to have been changed since being 
signed.

Validate Digital Signatures : How to validate a digital signature
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1.
2.
3.

Validating Digital Signatures
jPDFViewer validates any digital signatures upon opening a document. jPDF Viewer will 
first check that the digital signatures in the document use valid certificates and that the 
document has not been changed. It will then check that the certificate used to issue the 
digital ID in the signature was issued by a trusted certificate authority.

Validating Digital Signatures

Depending on the results of the validation, jPDF Viewer will display one of three icons 
on the signature:

The signature validated correctly, that there were no changes made to the 
document, and that the issuing certificate authority is trusted.

 

The signature validated correctly, but there might be some problems, such as 
the digital ID being issued by a certificate authority that is not trusted.

 

There were problems validating the signature. The problems can include any 
changes to the document after the signature was applied.

 

Checking Additional Validation Details

Using the Hand Tool  click the signature that you wish to validate.
This will display a dialog showing the Signature Validation Status
Once complete, to close the dialog, click on Close or press Esc on the keyboard



PDF Layers
PDF layers allow documents to have content placed either above or below other content 
within the document. Individual layers within a PDF can be displayed or hidden by the 
user if needed. jPDFViewer supports the following layer functions:

Note: In order to work with Layers you will first need to display the Layers Pane.  

Show/Hide Layers: How to show or hide selected layers

Displaying the Layers Pane

The layers pane is located on the left of the jPDFViewer window. Click on "Layers" to 
display the layers in the PDF document.
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